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DataMan Fixed Mount Readers Reference is a complete 
online hardware reference for the DataMan 300 and 500. 
Cognex->DataMan Setup Tool v x.x->Documentation->Reference Manual
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About DataMan 500 For More Information...
The DataMan 500 is a high-
performance, fixed-mount ID 
reader that offers the following 
advanced features:

•	 Automatic detection and 
triggering when codes enter 
the field of view.

•	 Ultra-sensitive custom 
image sensor that allows 
short exposures to freeze 
part motion.

•	 High-performance 
processing unit that provides 
extremely short cycle times.

•	 Automatic regulation of 
exposure time and gain to 
provide maximum performance.

•	 Electronically controlled solid-state variable focus system.
•	 Dynamically configurable network-based multiple-reader decoding 

(“master-slave”). 

The DataMan 500 provides advanced Ethernet connectivity, support for 
serial and discrete I/O, as well as advanced options for lighting and optics. 

The DataMan 500 is packaged in a rugged, IP65-rated housing, and 
it provides numerous ease-of-use features, including one-button code 
training.

This document provides basic information about how to configure and 
use the DataMan 500. Additional information is available through the 
Windows Start menu after you install the DataMan software on your PC:

DataMan Communications & Programming Guide shows 
how to integrate your DataMan reader with your automation 
software and factory network.
Cognex->DataMan Setup Tool v x.x->Documentation->Communications &
Programming

DataMan Reader Configuration Codes provides printable 2D 
codes that you can use to configure the DataMan reader.
Cognex->DataMan Setup Tool v x.x->Documentation->Reader Configuration Codes

DataMan Questions and Answers provides context-sensitive 
information. You can view this help inside the setup tool or as a 
standalone help file.
Cognex->DataMan Setup Tool v x.x->Documentation->DM500->Questions and Answers

Release Notes list detailed system requirements and additional 
information about this DataMan software release.
Cognex->DataMan Setup Tool v x.x->Documentation->DataMan v x.y.z Release Notes



I/O Cable M12 
to flying leads 
(right-angle) (CCB-
M12IO-R05)
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DataMan 500 Systems

High-Speed 
Part Moving 
Applications

Omni-
directional 
Code Reading

1DMax™ — 
Best-In-Class 
1D Reading

IDQuick™ — 
High-Speed  
2D Reading 

DataMan 500L 
(DMR-500L-xx) √ √

DataMan 500QL 
(DMR-500QL-xx) √ √ √

DataMan 500X 
(DMR-500X-xx) √ √ √ √

DataMan 500 Accessories
CD-ROM 
(Setup Tool and Drivers)
(206-6400-400)

Quick Reference 
Guide 
(590-7145)

Ethernet M12 to RJ45 
cable 
(CCB-84901-1003-xx)

I/O Cable M12 to 
flying leads (CCB-
M12IO-S05)

RS-232 cables 
(CCB-M8X4-xx)

AC Power over 
Ethernet (PoE) 
Injector 
(CPS-AC-POE1A-xx)

High-power lighting 
module 
(DM500-HPIA-000)

Liquid Lens Module 
(DM500-LLM-013 or 
DM500-LLM-018)

24V Power over 
Ethernet (PoE) DIN-
RAIL Mount Adapter 
(CPS-24V-POE1)



8  DataMan 500 Quick Reference Guide DataMan 500 Quick Reference Guide   9

User LEDs

Reader Layout

Pushbutton 

System LED

User LED 

•	 Push to read
•	 Push and hold 3 seconds to 

train
•	 Use Setup Tool to program 

additional button functions
•	 Green (pulse): Read
•	 Red (pulse): No read
•	 Red/Green (long pulse): 

Train or Optimize Focus 
result

•	 Yellow: Untrained
•	 Green: Trained

Mounting holes 
(M3 X 5mm)

Ethernet

Laser safety notice

RS-232
I/O

Laser aimer Laser aimer 

Status LED 

•	 Yellow: Power
•	 Green: Ethernet connected
•	 Blink: Data transfer

Illumination LED Illumination LED

Illumination LED Illumination LED



DataMan 500 ships with no lens installed. You must install either a 
standard CS-mount lens or a variable-focus liquid lens module before 
using your reader.

Do not leave the 
DataMan sensor 
exposed to the 
environment!

WARNING:Make sure your reader is 
unpowered before installing the lens.60 (2.36)

14.9 (0.587)

70.0 (2.75)

35 (1.38)

48.86(1.92)

38 (1.50)

mm (inches)

46.935(1.85)

97.99 
(3.86)

27 (1.06)

Observe the following DataMan 500 dimensions when installing your reader.

10  DataMan 500 Quick Reference Guide DataMan 500 Quick Reference Guide   11

Installing the Lens Dimensions

Remove the front cover, if attached, and lens cover.

Remove the four mounting 
screws from the corners of 
the front cover and remove 
the cover.

Unscrew the protective 
cover from the lens mount.

Do not discard screws!i

1



i

1 2
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Use CS- to C-mount adapter 
ring for C-mount lenses.

Installing CS-Mount Lens

Install lens. Re-attach front cover.

1 3

4 2

Tighten in sequence. 
Torque limit: 9 N-cm 
(0.8 Lb-In).



Make sure that C-to-CS mount adapter is not installed.

Do not pinch or pull cable while installing liquid lens module. Align slot in liquid lens module with key in lens mount.
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1

Installing Liquid Lens Module

Attach liquid lens module to Dataman 500.



2
Insert liquid lens cable into connector. 

Do not pinch or pull cable. 

Insert and remove cable using plug. 

While holding liquid lens module in place, tighten locking ring.

Installing Liquid Lens Module (Continued)
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Connect liquid lens cable



Installing Liquid Lens Module (Continued)
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1 3

4 2

Re-attach front cover.3

Tighten in sequence. 
Torque limit: 9 N-cm 
(0.8 Lb-In).

Avoid pinching or 
crimping wires when 
attaching cover.

For the 13.3 mm lens, reattach the front plastic cover and make sure you 
add the light baffle before you attach the lens cover.

For the 18.8 mm lens, attach the front plastic cover and tighten the 
screws.



Setting Focus 
There is a range of reading distances available for different code sizes 
and focus positions. To set focus on your reader, use the following options 
depending on whether you use a liquid lens or a manual focus lens.

Liquid Lens Manual Focus Lens

Focus Feedback (Results Display) Focus Feedback (Results Display)

Optimize Focus (Focus Settings)

Focus Sweep (Focus Settings)

For setting Focus Sweep, follow these guidelines:

•	 If your application has a consistent reading range, set the focus 
range to a limited depth of field with no steps (for example, set it to 
20) or with limited steps (for example, set it to 2 steps between 0 
and 30). This way you can achieve fast performance.

•	 If your application has a variety of code types and sizes, set the focus 
range to a wider depth of field with increased number of steps (for 
example, set it to 6 steps between 0 and 200). This way you can get 
better coverage.

Both Optimize Focus and the Focus Feedback use the same 
procedure for testing the current focus. They consider various 
subregions of the image.

For maximizing the performance of Optimize Focus and Focus Feedback, 
observe the following:

•	 Use a focus target (such as the one supplied with this Quick 
Reference Guide) that includes high-contrast features and is big 
enough that it fills at least a 100x100 pixel region in the center of the 
field of view at the desired working distance.

•	 Make sure the target is perfectly flat (avoid floppy pieces of paper).
•	 Make sure that the target is perfectly perpendicular to the optical axis 

of the reader.

20  DataMan 500 Quick Reference Guide DataMan 500 Quick Reference Guide   21



•	 Make sure that the rest of the field of view (such as the part not covered by 
the focus target) does not contain any high-contrast features. For example, 
you would ideally fill the entire field of view with a white card or sheet of 
paper (no shadows), then position the focus target in the middle. 

•	 The supplied focus target (120x120mm) is appropriate for typical working 
distances. If you are using a working distance such that the target does 
not completely fill the image, make sure that there are no high-contrast 
features visible outside of the target (see previous bullet).

Perform the following steps to use Focus Feedback:

Setting Focus (Continued)

1.	Connect the reader to the Setup Tool.

2.	On the Results Display pane, check the Focus Feedback option and enable 
Live Display.

3.	The Focus Feedback column is displayed in colors ranging from red (bad 
focus) through yellow to green (sharp focus).

Position the reader in a way that the focus column becomes green. This makes 
sure that the lens is in focus and you will be able to decode the image.

Configuring a Light Curtain
In automatic focus mode you can configure a light curtain as a package 
height sensor. The DataMan 500 will automatically set its focus position 
based on the detected surface height. For more information, see the 
DataMan Fixed Mount Readers Reference.
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1D

2D

150 mm (5.9 in)

100mm

in

0

0 3

200 300

6 9 12

400 500 600

15 18 21

75 mm (2.95 in)

299 mm (11.7 in)

60 - 419 mm (2.4 - 16.4 in)

60 - 522 mm (2.4 - 20.5 in)

60 - 349 mm (2.4 - 13.7 in)

60 - 695 mm (2.4 - 27.4 in)

0

mm in

100

100

200

200

6

6

3

3

24

60 - 209 mm (2.4 - 8.2 in)10 mil 

20 mil 

20 mil 

10 mil 

15 mil 
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Reading Distance and Field of View (18.8mm Liquid Lens Module DM500-LLM-018)
For the DataMan 500, two liquid 
lens modules are available:

•	 An 18.8 mm lens (DM500-
LLM-018) suitable for reading 
distant objects, such as on an 
assembly line or as a high-
magnification lens.

•	 A 13.3 mm lens (DM500-
LLM-013) suitable for reading 
objects at close distances.

Reading distance and field of 
view charts are provided for both 
modules.

For CS-mount lenses, the lens’s focal 
length, focus setting, and aperture 
setting determine the field of view and 
reading distance.



1D

2D

218 mm (8.58 in)

100mm

in

0

0 3

200 300

6 9 12

400 500 600

15 18 21

109 mm (4.29 in)

437 mm (17.2 in)

60 - 280 mm (2.4 - 11 in)

60 - 351 mm (2.4 - 13.8 in)

60 - 232 mm  (2.4-9.1 in)

60 - 470mm (2.4 -18.5 in)

0

mm in

100

100

200

200

6

6

3

3

24

60 - 137 mm (2.4 - 5.3 in)10 mil 

20 mil 

20 mil 

10 mil 

15 mil 

Reading Distance and Field of View (13.3mm Liquid Lens Module DM500-LLM-013)
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Do not stare into beam when adding, removing, or 
changing cables. Cognex recommends to unpower the 
reader any time you make physical changes to it. 

Connecting the Reader

Ethernet

RS-232 PoE injector

In

Out

M12 to RJ45

Supply power to the reader using a Power over Ethernet (PoE) injector. Cognex 
recommends the following connection sequence: 

1.	Connect the PoE injector with the Ethernet installation (both sides of the 
patch cable). 

2.	Connect the power cord (AC 230V/110V) to the PoE injector.

3.	Connect the reader to the PoE injector.

(optional)

To disconnect the reader:

1.	Disconnect the reader from the PoE injector.

2.	Disconnect the power cord from the PoE injector.

3.	Disconnect the PoE injector from the Ethernet installation.
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Installing DataMan 500 Software
1.	Check the DataMan Release Notes for a full list of system 

requirements. 

2.	 Insert CD-ROM and follow the on-screen prompts.

3.	Connect the DataMan 500 to your PC. 

4.	 Launch the Setup Tool and click Refresh.

Detected readers will appear under COM ports or Network devices, 
or both.

5.	Select a reader from the list and click Connect. 

RS-232 connections
Devices connected to PC 
serial ports listed here.

Ethernet connection
Devices detected on 
the network listed here 
(“DM500_” with last 
6 characters of MAC 
address, printed on back 
of the reader).
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Start the Setup Tool

Quick Setup

Configure your reader in a few basic steps

Connect to Reader
Establish a connection to the reader

Results Display
View results

Light and Imager Settings
Choose a trigger type and other acquisition 
parameters

System Settings
Configure input and output signals

Table View
See all the selectable values in the Setup Tool 
in one table

Trigger button Latest image Context based help

Read history Train status Connection status

Connect the reader to the Setup Tool to 
configure it with the type of symbologies 
it will decode as well as other parameters, 
such as the type of trigger it will use and the 
format of the results it will generate. 

Region of interest
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Troubleshooting an Ethernet Connection
Based on your network configuration, the Setup Tool may not be able to 
communicate with the reader and it will not appear in the list of Network 
devices. 

First check your Ethernet connection with the reader and click Refresh in the 
Setup Tool. Next, scan the Enable DHCP code in the Reader Configuration 
Codes document available from the Start menu. This might allow the reader to 
acquire a suitable IP address from a DHCP server on your subnet. 

If the reader still does not appear, you can use either the Add Device or 
Force Network Settings options in the Setup Tool. 

If you know the IP address of the reader, use the Add Device option. If you 
do not know the IP address, use the Force Network Settings options. Either 
method should allow the DataMan 500 reader to appear in the list of Network 
devices so that you can connect to it through the Setup Tool and your 
Ethernet connection.

You can also use the RS-232 connection to configure the reader with 
parameters that allow it to communicate over your Ethernet network. 

Industrial Protocols
The DataMan 500 series readers support the following industrial 
protocols:

•	 EtherNet/IP™
•	 PROFINET
•	 MC Protocol
•	 Modbus TCP

There are three ways to enable or disable Industrial Protocols. Using 
either method, a reboot is required for the changes to come into effect.

•	 Enable the protocols using the Industrial Protocols pane of the 
Setup Tool (under Communication Settings).

•	 Scan the appropriate Reader Configuration codes (see Reader 
Configuration Codes available through the Windows Start menu).

•	 Send the appropriate DMCC (see Command Reference available 
through the Windows Start menu).

For more information on using the industrial protocols, read the 
DataMan Communications and Programming Guide available through 
the Windows Start menu.

Select industrial 
protocol samples and 
tools you want to use 
when you install the 
DataMan Software.
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Use the Setup Tool Menu Bar
The In1 button on the toolbar creates a virtual rising edge signal on Input 1. Use the In1 
button to activate various actions such as training a code, optimizing brightness or setting 
a match string without a physical input 1 channel.

Each reader can store its current set of runtime parameters to a configuration (.cfg) file, 
which contains information such as the enabled symbologies and how any output data 
should be formatted. 

The same configuration file can be loaded onto multiple readers, as the file does not 
contain identification information such as the IP address or device name of the reader 
used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which stores the set 
of runtime parameters plus any identification data, such as the name of the device, its IP 
address, subnet mask, and so on. Cognex recommends generating a device configuration 
file for each reader to allow you to restore a reader to its operating state with minimal 
effort. 

Use the File menu of the Setup Tool to manage .cfg and .cdc files: 

File Menu

Open Configuration Open a saved .cfg configuration file. 

Save Configuration Create a .cfg configuration file of current runtime 
parameters. 

Print Configuration Code Generate a programming codes sheet representing your 
reader’s .cfg configuration.

Restore Device Load a saved device configuration .cdc file, with run-
time parameters plus device-specific information for a 
particular DataMan 300 series reader. 

Backup Device Create a device configuration .cdc file for a specific 
reader. 

Print Device Backup Code Generate a programming codes sheet representing your 
reader’s .cdc configuration.

System Menu

Save Settings Save the current parameters to non-volatile 
memory, which allows the reader to restore these 
settings each time you reboot it.

Reset Configuration Reset all configuration parameters in RAM (volatile 
memory) to the default settings. 

Update Firmware Update the reader software.

Upload Feature Key Unlock additional features available in the reader 
software if you have the right key.

Show Device Log Error and exception conditions, such as missed 
triggers and trigger overruns are logged.

Delete Device Log Clear your device log.

Export Parameters Save (all or only the non-default) parameters of 
your device in a text file.

Load Image Load an 8-bit uncompressed grey-scale .bmp or 
.jpg image for analysis.

Save Image Save the latest acquired image with the .jpg or 
.bmp file format.

Save Burst Images Save the latest batch of burst images.

Use the Edit menu for standard Cut, Copy and Paste operations. 

Use the View menu to view reader information (serial number, firmware version, 
and so on) and to enable and disable various elements of the Setup Tool, and the 
Tasks menu to switch between various Setup Tool options. 

Use the System menu to manage the current settings on the reader and to 
upgrade the features it currently supports: 

Use the Help menu to display Setup Tool version information. 
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DataMan 500 Triggering
DataMan 500 supports self-triggered operation. In self-trigger mode, 
at an interval you configure, the reader automatically detects and 
decodes codes in its field of view. The high-speed image acquisition and 
processing capabilities of the DataMan 500 allow it to detect and decode 
codes at up to 80 codes per second, multiple decodes per scan. If you 
set a higher re-read delay than the trigger interval, there is a code 
output only once until the code is out of the field of view for the duration 
of the re-read delay.
DataMan 500 also supports these additional trigger modes: 
•	 Single (external trigger): Acquires a single image and attempts to 

decode any symbol it contains, or more than one symbol in cases 
where multicode is enabled. The reader relies on an external trigger 
source. 

•	 Presentation: Scans, decodes and reports a single code in the field of 
view. The reader relies on an internal timing mechanism to acquire 
images. 

•	 Manual: Begins acquiring images when you press the trigger button 
on the reader, and continues acquiring images until a symbol is found 
and decoded or you release the button.

•	 Burst: Performs multiple image acquisitions based on an external 
trigger and decodes any symbol appearing in a single image or within 
a sequence of images, or multiple symbols in a single image or within 
a sequence of images when multicode is enabled. You can control the 
number of images within each burst and the interval between image 
acquisitions.

•	 Continuous: Begins acquiring images based on a single external 
trigger and continues to acquire and decode images until a symbol 
is found and decoded, or until multiple images containing as many 
codes as specified in multicode mode are located, or until the trigger 

Mounting the Reader

The DataMan 500 reader provides four threaded attachment points. Use 
all of them when mounting your reader. For exact dimensions, see the 
DataMan Fixed Mount Readers Reference.

To avoid reflections and glare from part and label surfaces, mount the 
reader at a 15° angle from vertical.

15°
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Multi-Reader Triggering

For trigger modes other than Presentation, the DataMan 500 supports 
multi-reader triggering, also known as master-slave configuration. In 
this configuration, you configure multiple DataMan 500 readers as a 
group. Whenever any reader in the group is triggered, all the readers 
are triggered and the results from all the readers are assembled and 
transmitted by a single reader that you designate as the master.
Multi-reader triggering is used to support extended field of view reading 
and reading codes from multiple product surfaces:

To configure multi-reader triggering, select the Master/Slave pane in 
the Setup tool (under System Settings in  Advanced view). For more 
information, see the DataMan Fixed Mount Readers Reference.

DataMan 500 Triggering (Continued)

•	 Press the trigger button on 
the reader.

•	 Send a pulse on the I/O cable:

•	 Trigger + (red/blue)

•	 Trigger - (white)

•	 Send a trigger command over 
the RS-232 connection or 
Ethernet connection.

•	 Press <CTRL>-T on the 
keyboard.

•	 Click the Trigger button in the 
Setup Tool: 
 

is released. You can configure your reader to acquire images based on the start 
and stop signal from separate digital IO pulses.

If you are using external triggering you can use any of these methods to 
trigger DataMan 500:
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Training the Reader
Training your reader with the expected symbology can decrease the time 
required to decode successive symbols. To train your reader, first switch 
to Single mode, then place a code in front of the reader and do one of the 
following: 

•	 Press and hold the trigger button for a 
minimum of 3 seconds. 

•	 Click and hold the trigger button in 
the Setup Tool for a minimum of 3 
seconds. 

•	 Click Train Code in the Results Display pane. 

You can now switch to Burst, Continuous or Self trigger modes if necessary.

NOTE that only a single symbol of each symbology kind can be trained.

Training Feedback
The middle LED on the reader glows green to indicate that 
it is currently trained, or yellow to indicate that it is not 
trained. 

Connect the reader to the Setup Tool to untrain it and 
allow it to recognize other enabled symbologies.

Incremental Training for Multiple Symbologies
If you want to train the reader to recognize multiple symbologies, you 
can present a single image showing all the desired symbologies and 
perform the training procedure previously described. 

If you cannot present a single image showing all the necessary 
symbologies, you can enable incremental training on the Training tab 
of the Symbology Settings pane: 

With incremental training enabled, you can train the reader using 
multiple images showing the symbologies you expect to decode. The 
reader will train each new symbology while retaining the existing 
trained symbologies.  



1

2 Attach lighting module to reader.
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High-Power Lighting Module

WARNING

Disconnect 
DataMan from 
power before 
inserting/
removing 
lighting module.

Remove the lens cover.

The high-power lighting module (available as an accessory) allows you to 
work with higher line speeds and greater working distances than the built-in 
internal illumination.

Follow the steps in this section to install and remove the module.

Remove and retain the four 
mounting screws from the 
corners of the front cover 
and remove the cover.

i

1 3

4 2
9 N-cm (0.8 Lb-In)

Observe 
torque limit

Tighten in 
sequence

Use screws 
supplied with 
lighting module.

Avoid pinching or 
crimping wires 
when attaching 
cover.



 1 2

 10  9

 812

 3

11 4

 7

 6

 5
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I/O Cable

Pin # Signal Name Wire Color

1 Out 0 Brown

2 N/C Blue

3 Common In White

4 In 2 Green

5 In 1 Pink

6 Common Out Yellow

7 Out 2 Black

8 Out 3 Grey

9 Out 1 Red

10 N/C Purple

11 In 3 Grey/Pink

12 In 0 Red/Blue

The I/O cable provides access to trigger and high-
speed outputs. Unused wires can be clipped short or 
tied back using a tie made of non-conductive material. 

Device pin numbering. 
Plug pin numbers are mirrored.

Acquisition Triggering

The acquisition trigger input on the reader is opto-isolated. To trigger 
from an NPN (pull-down) type photo-detector or PLC output, connect 
In 0 to +24V and connect Common In to the output of the detector. 
When the output turns on, it pulls Common In down to 0V, turning the 
opto-coupler on. 

To trigger from an PNP (pull-up) photo-detector or PLC output, connect 
In 0 to the output of the detector and connect Common In to 0V. 
When the output turns on, it pulls In 0 up to 24V, turning the opto-
coupler ON. 

In 0

Common In
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High-Speed Output Lines

The high-speed outputs can be used as either NPN (pull-down) or PNP (pull-up) 
lines. For NPN lines, the external load should be connected between the output 
and the positive supply voltage (<28V). The outputs pull down to less than 3V 
when ON, which causes current to flow through the load. When the outputs are 
OFF, no current flows through the load. 

Controller Opto-isolators

NPN Out

Out Common

Specification Description

Voltage 28V maximum through external load

Current 50mA maximum sink current

OFF state leakage current 100µA

External load resistance 240 Ohms to 10K Ohms

Each line rated at a maximum 50mA, protected against 
over-current, short circuits and transients from switching 
inductive loads. High current inductive loads require 
external protection diode. 

PTC 
Fuse

For PNP lines, the external load should be connected between the output 
and the negative supply voltage (0V). When connected to a 24VDC 
power supply, the outputs pull up greater than 21V when ON, and 
current flows through the load. When the outputs are OFF, no current 
flows through the load.  

Out 
Common

NPN Out

Controller Opto-isolators

PTC 
Fuse
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High Speed Output Wiring

To connect to an NPN-compatible PLC input, connect Output 0 or Output 1 
directly to the PLC input. When enabled, the output pulls the PLC input down to 
less than 3V. 

GND 
24VDC

Common High Speed Out 0

NPN PLC
NPN Compatible Input 
GND 
24VDC

To connect to a PNP-compatible PLC input, connect Output 0 or Output 1 
directly to the PLC input. When enabled, the output pulls the PLC input up to 
greater than 21V. 

GND 
24VDC

Common High Speed Out 0

PNP PLC
PNP Compatible Input 
GND 
24VDC

GND 
24VDC

Common

Load 
(Coil, Relay...) 
Not to exceed 
50mA

High Speed Out 0

To connect the high-speed outputs to a relay, LED or similar load, 
connect the negative side of the load to the output and the positive side 
to +24V. When the output switches on, the negative side of the load 
is pulled down to less than 3V, and 24 appears across the load. Use a 
protection diode for a large inductive load, with the anode connected to 
the output and the cathode connected to +24V. 
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RS-232 Cable
The RS-232 cable provides an optional connection between the reader and 
your PC. 

2 4
RxD

3
GND

TxD

1
3 RxD
2 TxD

5 GND

235

Weight 350 g

Operating 
Temperature

0ºC — 40ºC (32ºF — 104ºF)

Storage 
Temperature

-10ºC — 60ºC (-14ºF — 140ºF)

Maximum 
Humidity

95% (non-condensing)

Environmental IP65 (with cable or protection cap attached to all connectors, 
front cover properly installed)

Vibration EN61373 including IEC 60068-2-6,60068-2-64 6.4, and 60068-
2-27

RS-232 RxD, TxD according to TIA/EIA-232-F

Codes Data MatrixTM (IDMax: ECC 0, 50, 80, 100, 140, and 200; 
IDQuick: ECC200)

QR Code and microQR Code
UPC/EAN/JAN

Codabar, Interleaved 2 of 5, Code 39, Code 128, and Code 93, 
Pharma, Postal, RSS/CS, PDF 417, MicroPDF 417

Discrete I/O 
operating limits

Trigger, 
HS 
Output 
0,1

Max output current: 50 mA @ 28 VDC 

Output load: 470 Ω @ 24 VDC; 150 Ω @ 12 VDC

Input voltage limits:- 28 VDC — +28 VDC

Input current: 4.2 mA @ 24 VDC; 2.0 mA @ 12 VDC

Power Supply 
Requirements

Class 3
PoE 
injector

Maximum power:  5W
                             

DataMan 500 Specifications 
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radio frequency energy and, if not installed and 
used in accordance with the instructions, may 
cause harmful interference to radio communica-
tions. Operation of this equipment in a residential 
area is likely to cause harmful interference, in 
which case the user will be required to correct the 
interference at personal expense.

Canadian Compliance
This Class A digital apparatus complies with 
Canadian ICES-003.
Cet appareil numérique de la classe A est con-
forme à la norme NMB-003 du Canada.

C-Tick Statement

  
Conforms to AS/NZS CISPR 22/ EN 55022 for Class 
A Equipment.

European Compliance

  
The CE mark on the product indicates that the 
system has been tested to and conforms to 
the provisions noted within the 2004/108/EEC 
Electromagnetic Compatibility Directive and the 
2006/95/EEC Low Voltage Directive. 

For further information please contact:
	 Cognex Corporation
	 One Vision Drive
	 Natick, MA 01760
	 USA

Compliance Notice 
The DataMan 500 series meets or exceeds the 
requirements of all applicable standards organi-
zations for safe operation. However, as with any 
electrical equipment, the best way to ensure safe 
operation is to operate them according to the 
agency guidelines that follow. Please read these 
guidelines carefully before using your device.

Regulator Specification
USA FCC Part 15, Class A

FDA/CDRH Laser Notice No 50
Canada ICES-003
European 
Community

EN55022:2006 +A1:2007, Class A
EN55024:1998 +A1:2001 +A2: 
2003
EN60950
EN60825-1

Australia C-TICK, AS/NZS CISPR 22 / EN 
55022 for Class A Equipment

Japan J55022, Class A

FCC Class A Compliance Statement

 
This equipment has been tested and found to 
comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC rules. These limits 
are designed to provide reasonable protection 
against harmful interference when the equip-
ment is operated in a commercial environment. 
This equipment generates, uses, and can radiate 

Cognex Corporation shall not be liable for use 
of our product with equipment (i.e., power 
supplies, personal computers, etc.) that is not 
CE marked and does not comply with the Low 
Voltage Directive.

Laser Safety Statement

Compliance with FDA performance standards 
for laser products except for deviations 
pursuant to Laser Notice No. 50, dated June 
24, 2007.

This device has been tested in accordance 
with IEC60825-1 2nd ed., and has been certi-
fied to be under the limits of a Class 2 Laser 
device.

Use of controls or adjustments or perfor-
mance of procedures other than those speci-
fied herein may result in hazardous radiation 
exposure.

UL and cUL Statement

  
UL and cUL listed: UL60950-1 1st ed. and CSA 
C22.2 No.60950-1 1st ed.

For European Community Users
Cognex complies with Directive 2002/96/EC 
OF THE EUROPEAN PARLIAMENT AND OF THE 
COUNCIL of 27 January 2003 on waste electrical 
and electronic equipment (WEEE).

This product has required the extraction and use 
of natural resources for its production. It may 
contain hazardous substances that could impact 
health and the environment, if not properly 
disposed. 

In order to avoid the dissemination of those sub-
stances in our environment and to diminish the 
pressure on the natural resources, we encourage 
you to use the appropriate take-back systems 
for product disposal. Those systems will reuse or 
recycle most of the materials of the product you 
are disposing in a sound way.

The crossed out wheeled bin symbol informs 
you that the product should not be disposed of 
along with municipal waste and invites you to 
use the appropriate separate take-back systems 
for product disposal.
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If you need more information on the collection, reuse, and recycling systems, please contact your local or 
regional waste administration.

You may also contact your supplier for more information on the environmental performance of this product.

i

Warnings and Notices
CAUTION: This device requires the use of a PoE Class 3 or 48V DC LPS power 
supply.

NOTE: For product support, contact http://support.cognex.com

CAUTION: IP protection is ensured only when all connectors are attached to cables 
or shielded by a sealing cap. 

LASER LIGHT, DO NOT STARE INTO BEAM: CLASS 2 LASER PRODUCT

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY CAUSE SERIOUS 
INJURY

•	 CAUTION - Use of controls or adjustments or performance of 
procedures other than those specified herein may result in hazardous 
radiation exposure.  

•	 Do not attempt to service or repair this product -- return it to Cognex 
for service.  

•	 Do not permit anyone other than Cognex Corporation to service, 
repair, or adjust this product. 

•	 Do not attempt to open or modify this device except as described in 
this document.

•	 Do not direct or reflect laser light toward people or reflective objects. 
•	 Do not operate this device if it is damaged or if the covers or seals 

are missing or damaged. 

This Laser Product is designated as Class 2 during all procedures of 
operation.

Wavelength 650 nm

Laser Power for classification < 1 mW

Beam Diameter < 3mm at aperture

Divergence < 1.5 mrad

For assistance contact Cognex Corporation at http://support.cognex.com
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